ESET PROTECT
Virtual Appliance Deployment Guide
Click here to display the online version of this document

Copyright ©2021 by ESET, spol. s r.o.
ESET PROTECT was developed by ESET, spol. s r.o.
For more information visit https://www.eset.com.
All rights reserved. No part of this documentation may be reproduced, stored in a retrieval system or transmitted
in any form or by any means, electronic, mechanical, photocopying, recording, scanning, or otherwise without
permission in writing from the author.
ESET, spol. s r.o. reserves the right to change any of the described application software without prior notice.

Technical Support: https://support.eset.com

REV. 9/8/2021

1 ESET PROTECT Virtual Appliance ...................................................................................................... 1
1.1 About help ................................................................................................................................. 1
1.2 Prerequisites ............................................................................................................................. 2
1.2 Recommended system conﬁgurations ................................................................................................. 3
2 Supported hypervisors ...................................................................................................................... 3
3 ESET PROTECT VA implementation phases and maintenance .......................................................... 4
4 Download ESET PROTECT Virtual Appliance ...................................................................................... 4
5 ESET PROTECT VA passwords ........................................................................................................... 5
6 ESET PROTECT Virtual Appliance deployment process ..................................................................... 6
6.1 vSphere ..................................................................................................................................... 6
6.2 VMware Workstation/Player ......................................................................................................... 8
6.3 Microsoft Hyper-V ..................................................................................................................... 10
6.4 Oracle VirtualBox ..................................................................................................................... 12
6.5 Citrix ....................................................................................................................................... 14
7 ESET PROTECT Virtual Appliance conﬁguration ............................................................................... 16
7.1 ESET PROTECT Server Appliance ................................................................................................. 17
7.2 ESET PROTECT MDM Appliance ................................................................................................... 20
8 ESET PROTECT Virtual Appliance Management Console ................................................................. 24
8.1 Set static IP address ................................................................................................................. 25
8.2 Enable/Disable remote access .................................................................................................... 27
8.3 Backup database ...................................................................................................................... 29
8.4 Restore database ..................................................................................................................... 31
8.5 Reset after snapshot revert ....................................................................................................... 32
8.6 Pull database from other server ................................................................................................. 33
8.7 Change VM password ................................................................................................................ 37
8.8 Change database password ....................................................................................................... 38
8.9 Rejoin domain .......................................................................................................................... 39
8.10 Conﬁgure domain ................................................................................................................... 41
8.11 Factory reset .......................................................................................................................... 42
9 Webmin Management Interface ...................................................................................................... 44
9.1 Dashboard ............................................................................................................................... 45
9.2 System .................................................................................................................................... 47
9.3 Servers .................................................................................................................................... 48
9.3 ESET PROTECT ........................................................................................................................ 48
9.4 Others ..................................................................................................................................... 50
9.5 Networking .............................................................................................................................. 51
10 ESET PROTECT certiﬁcates ............................................................................................................ 52
11 ESET PROTECT VA upgrade/migration ........................................................................................... 53
12 ESET PROTECT VA disaster recovery ............................................................................................. 55
13 Troubleshooting ............................................................................................................................ 56
14 ESET PROTECT Virtual Appliance FAQ ........................................................................................... 57
14.1 How to ﬁnd out which ESET PROTECT components are installed ................................................... 57
14.2 How to enable ping on ESET PROTECT Virtual Appliance .............................................................. 58
14.3 Do I need to add other components to my ESET PROTECT VA? ...................................................... 59
14.4 How to enable Apache HTTP Proxy on my ESET PROTECT Virtual Appliance after initial conﬁguration

..............................................................................................................................................
..................
14.6 Conﬁgure LDAPS connection to a domain ..................................................................................
14.7 How to recover a forgotten password for ESET PROTECT VA ........................................................
14.5 How to conﬁgure LDAP to allow for Static Group synchronization on ESET PROTECT VA

59
60
60
61

..........................................................
..............................................................................
14.10 How to change port numbers for ESET PROTECT Virtual Appliance ..............................................
14.11 How to increase memory size for MySQL Server .......................................................................
14.12 Error with ESET PROTECT running on a Hyper-V Server 2012 R2 .................................................
14.13 How to improve Oracle VirtualBox performance ........................................................................
14.14 How to enable YUM command under HTTP Proxy server ............................................................
14.15 How to update the operating system on a machine running ESET PROTECT VA Server ..................
14.16 How to disable SELinux permanently .......................................................................................
14.17 How to restart Virtual Appliance Management Console .............................................................
14.18 How to use Proxy for Agents connections ................................................................................
14.19 How to enable Hardware Inventory on older Virtual Appliances (6.x) ..........................................
14.20 How to enable SSH ................................................................................................................
15 End User License Agreement ........................................................................................................
16 Privacy policy ................................................................................................................................
14.8 How to change ESET PROTECT database connection string
14.9 How to set up Hyper-V Server for RD Sensor

61
61
62
63
63
63
63
64
64
65
65
65
65
66
72

ESET PROTECT Virtual Appliance
The ESET PROTECT Virtual Appliance (ESET PROTECT VA) is available for users who want to run ESET PROTECT in a
virtualized environment. Additionally, the ESET PROTECT Virtual Appliance simplifies deployment of ESET
PROTECT and is faster than using the All-in-one installer or component installation packages.
The ESET PROTECT VA can be deployed in most virtual environments. It supports native/bare-metal hypervisors
(VMware vSphere/ESXi and Microsoft Hyper-V) as well as hosted hypervisors that usually run on desktop
operating systems (VMware Workstation, VMware Player and Oracle VirtualBox), see Supported hypervisors for a
complete list.
This guide describes in detail how to deploy and manage ESET PROTECT VA, including its new features:
• ESET PROTECT Virtual Appliance Management Console - is a simple Text-based user interface (TUI) based
around a main menu. The interface will assist you with text commands by asking you to specify values when
necessary. Even users who do not have advanced experience with CentOS 7 or other Linux operating systems
can use and manage ESET PROTECT VA with ease. Some important features include:
oSet static IP address - manually specify the static IP address if your ESET PROTECT VA is not assigned an
IP address by a DHCP server.
oPull database from other server - if you need to upgrade or migrate your ESET PROTECT VA.
oBackup and restore of ESET PROTECT database - these features are important for your disaster
recovery strategy and are available in case of problems with ESET PROTECT VA.
oFactory reset - restores the appliance to a freshly deployed state. This can be useful if you experience
issues with ESET PROTECT VA. Have a backup of the database ready to avoid losing your data.
• Webmin Management Interface - a third-party web-based interface that simplifies the management of a
Linux system. It gives you the convenience of managing your ESET PROTECT VA remotely from your web
browser using an intuitive interface. The most important Webmin modules are described in this document.

About help
This guide, the VA Deployment Guide, provides instructions to deploy and configure the ESET PROTECT Virtual
Appliance(ESET PROTECT VA). This guide is intended for anyone who wants to deploy, manage and update ESET
PROTECT VA.
For consistency and to help prevent confusion, the terminology used throughout this guide is based on the ESET
PROTECT parameter names. We also use a set of symbols to highlight topics of particular interest or significance.

Note
Notes can provide valuable information, such as specific features or a link to a related topic.

Important
This requires your attention and it should not be skipped. Usually, it provides non-critical but
significant information.
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Warning
Critical information you should treat with increased caution. Warnings are placed specifically to
deter you from committing potentially harmful mistakes. Please read and understand text placed in
warning brackets, as it references highly sensitive system settings or something risky.

Example
Example scenario that describes a user case relevant for the topic where it is included. Examples are
used to explain more complicated topics.
Convention
Bold type
Italic type

Meaning
Names of interface items such as boxes and option buttons.
Placeholders for information you provide. For example, file name or path means you type the
actual path or a name of file.
Courier New Code samples or commands
Hyperlink
Provides quick and easy access to cross-referenced topics or external web location. Hyperlinks
are highlighted in blue and may be underlined.
%ProgramFiles% The Windows system directory which stores installed programs of Windows and others.
• Online Help is the primary source of help content. The latest version of Online Help will automatically be
displayed when you have a working internet connection. The ESET PROTECT online help pages include four
active tabs at the top navigation header: Installation/Upgrade, Administration, VA Deployment and SMB
guide.
• Topics in this guide are divided into several chapters and sub-chapters. You can find relevant information
by using the search field at the top.

Important
Once you open a User Guide from the navigation bar at the top of the page, search will be limited to
the contents of that guide. For example, if you open the Administrator guide, topics from the
Installation/Upgrade and VA Deployment guides will not be included in search results.

• The ESET Knowledgebase contains answers to the most frequently asked questions, as well as
recommended solutions for various issues. Regularly updated by ESET technical specialists, the
Knowledgebase is the most powerful tool for resolving various types of problems.
• The ESET Forum provides ESET users with an easy way to get help and to help others. You can post any
problem or question related to your ESET products.
• You can post your rating and/or provide a feedback on a particular topic in help: Click the Was this
information helpful? link underneath the help page.

Prerequisites
The following prerequisites must be met before ESET PROTECT Virtual Appliance deployment:
• You must use a supported hypervisor.
• Verify that the guest operating system (if a hosted hypervisor, such as VMware Workstation/Player or Oracle
VirtualBox is used) is supported.
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• Verify that system clock settings between the host and guest operating systems are synchronized.
• VT must be enabled in the host system BIOS. This feature may be named VT, Vanderpool Technology,
Virtualization Technology, VMX, or Virtual Machine Extensions. This setting is commonly located in the security
screen of the BIOS. The location of this setting varies depending on the system vendor.
• Make sure the connection for the network adapter on your Virtual Machine is set to Bridged (or, alternatively
NAT). During ESET PROTECT VA configuration, you can specify network settings including domain details so that
the Static Group Synchronization task will run properly.
• If you are using NAT mode, port forwarding must be configured on your virtual machine for ESET PROTECT to
be accessible from the network. Ports that need forwarding are displayed in the console window of your ESET
PROTECT VA after you have deployed and configured it.
• ESET PROTECT Virtual Appliance only supports IPv4 environments. While It is possible to manually set up an
IPv6 environment, IPv6 is not supported.

Important
We recommend that you create a snapshot of your newly deployed and configured ESET PROTECT
VA and synchronize it with Active Directory. We also recommend that you create snapshot prior to
deploying the ESET Management Agent on client computers.
• ESET PROTECT certificates are required to deploy ESET PROTECT MDM. You must have an ESET PROTECT
Server instance running to generate these certificates, which encrypt communication between ESET PROTECT
components.

Recommended system configurations
Depending on the size of your infrastructure, namely number of client machines that will be managed by ESET
PROTECT Virtual Appliance, take into account recommended and minimal virtual machine configuration.
The following sizing applies to ESET PROTECT Server and ESET PROTECT MDM Virtual Appliance:
Number of clients

Number of
RAM size
Cores

less than 5,000 clients 4

4 GB

more than 5,000 clients 8

8 GB

Other
Thick provisioned disk, manually change configuration to
increase memory size for MySQL.
Proportionally increase available resources for your ESET
PROTECT VA to prevent performance issues.

Important
If you are planning to have more than 5,000 managed clients, we highly recommend that you install
ESET PROTECT Server/MDM on a physical machine running Microsoft Windows Server with
Microsoft SQL Server.

Supported hypervisors
The ESET PROTECT Virtual Appliance (protect_appliance.ova) is a vmx-07 virtual hardware family type
appliance.
The Virtual Appliance is supported only on the listed hypervisors. Running it on other hypervisors is on user risk.
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Hypervisor

Version

✔
VMware vSphere/ESXi 6.5 and newer
✔
VMware Workstation 9 and newer
✔
VMware Player
7 and newer
Microsoft Hyper-V
Server 2012, 2012 R2, 2016, 2019 ✔
✔
Oracle VirtualBox
6.0 and newer
✔
Citrix
7.0 and newer

ESET
PROTECT
Server
Appliance

ESET
PROTECT
MDM
Appliance
✔
✔
✔
✔
✔
✔

Important
We recommend that you use a DHCP server in your network to assign your ESET PROTECT VA an IP
address. This IP address is necessary for access to the ESET PROTECT VA configuration web
interface. If you do not have a DHCP server in your network, you must Set static IP address.

ESET PROTECT VA implementation phases and
maintenance
The implementation of ESET PROTECT Virtual Appliance consists of the following main phases that are necessary
for successful deployment and configuration:
1.ESET PROTECT Appliance deployment process - actual deployment of ESET PROTECT Virtual Appliance OVA
file on your Hypervisor.
2.ESET PROTECT Virtual Appliance configuration - post-deployment configuration done via web interface of
the ESET PROTECT VA. It is a configuration page that lets you choose appliance type and then enter specific
details and properties required for that particular ESET PROTECT VA type to run correctly.
Further configuration and management is done via the TUI (Text-based User Interface) and Webmin:
1.ESET PROTECT Virtual Appliance Management Console - allows you to perform maintenance operations such
as back up and restore, password changes, factory reset, etc.
2.Webmin Management Interface - makes for an easy management of your ESET PROTECT VA.
Upgrade, migration and disaster recovery procedures:
ESET PROTECT VA upgrade/migration - if you want to upgrade your ESET PROTECT VA to the latest version, see
this section for details and step-by-step procedure. Also, the same procedure applies if you need to migrate your
ESET PROTECT VA.
ESET PROTECT VA disaster recovery - follow this procedure if ESET PROTECT VA stopped working and it is not
possible to fix the problem or if you are unable to recover a damaged ESET PROTECT VA instance.

Download ESET PROTECT Virtual Appliance
The ESET PROTECT Virtual Appliance comes as an OVA (Open Virtualization Appliance) file. It is available from the
download section. The appliance is available as protect_appliance.ova.
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If you are deploying your VA on Microsoft Hyper -V, use the protect_appliance.vhd.zip file instead of the
OVA file.
• protect_appliance.ova - contains multiple ESET PROTECT Appliance types. Deploy this file and
choose which type of appliance you want to run. You can choose from the following appliance types:
oESET PROTECT Server - An ESET PROTECT Server that will run on a dedicated VM. Also includes Rogue
Detection Sensor.
oESET PROTECT MDM - The mobile device management component only. If you do not want to expose
your ESET PROTECT Server, you can make the ESET PROTECT MDM VM accessible from the Internet to
manage mobile devices.

The OVA file is a template that contains a functional CentOS 7 operating system. To deploy the ESET PROTECT VA
OVA file, follow the instructions for your hypervisor. When using protect_appliance.ova, you can choose
which ESET PROTECT Appliance type you want your VM to run following deployment. When you have selected
the type, you can start configuring your ESET PROTECT Virtual Appliance. After you deploy the .ova file, select
the appliance type and configure settings for your VA. The VA is a complete environment with ESET PROTECT (or
one of its components).
Before you begin deployment, make sure that all prerequisites are met.
Once you finish the deployment and configuration process, you can connect to the ESET PROTECT Server using
the ESET PROTECT Web Console and start using ESET PROTECT.

Note
ESET provides the ESET PROTECT Virtual Appliances, however, ESET is not responsible for support
and maintenance of your OS or OS components. ESET PROTECT Virtual Appliances are designed to
simplify usage and deployment and come with a publicly available operating system that includes
non-ESET components. Managing and updating these components is the sole responsibility of the
user of the ESET PROTECT Virtual Appliance. We recommend that you regularly update the
operating system to prevent security issues.

ESET PROTECT VA passwords
ESET PROTECT Virtual Appliance uses a few different user accounts. The following table explains the different
account types:
Account type
Operating system
(CentOS) root

Default password
eraadmin

Database (MySQL) root eraadmin
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Description and use
This is an account which you can use to log into your ESET PROTECT
Virtual Appliance. It lets you access ESET PROTECT VA Management
Console and Webmin Management Interface, lets you perform
Factory reset or if you need to Pull database from other server.
Usually, you will be asked to enter your VM password.
This is a root account for the MySQL database server. It lets you
perform database operations such as database Backup or database
Restore. Usually, you will be asked to enter your database root
password.

Account type
Default password
Description and use
ESET PROTECT Web
specified during
This password is important because it lets you access ESET
Console Administrator ESET PROTECT VA
PROTECT Web Console.
configuration
The default password is changed during ESET PROTECT Virtual Appliance configuration. All the accounts above will
have the same password you have specified during ESET PROTECT VA configuration. However, each account can
be set with a different password. It is more secure to use different passwords, although it may be intricate when
using multiple passwords. You might want to find an effective way of handling multiple passwords for ESET
PROTECT VA to prevent confusion.

Note
When you deploy ESET PROTECT VA which is not configured yet, it uses the same password
eraadmin for all the above accounts until the password is changed during ESET PROTECT Virtual
Appliance configuration.
In case of a forgotten password for any of the above accounts, see chapter How to recover a forgotten password
for ESET PROTECT VA.

ESET PROTECT Virtual Appliance deployment process
Click the Hypervisor you will use to view deployment instructions:
• vSphere
• VMware Workstation/Player
• Microsoft Hyper-V
• Oracle VirtualBox
• Citrix

vSphere
Deploying ESET PROTECT VA in a vSphere Client
1.Connect to your vCenter Server using vSphere Client, or directly to ESXi server.
2.If you use the vSphere Client for desktop, click File > Deploy OVF Template. If you use the vSphere Web
Client, click Actions > Deploy OVF Template.
3.Click Browse, navigate to the protect_appliance.ova file that you downloaded from ESET.com and then
click Open.

Important
Unsupported versions of VMware ESXi do not accept SHA-256 certificates. If you see a certificate
error when importing the ESET PROTECT VA 8.0 .ova package, you need to delete the .cert file
from .ova and then proceed with the deployment.
4.Click Next in the OVF Template Details window.
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5.Read and accept the End User License Agreement (EULA).
6.Follow the instructions on screen to complete installation and specify the following information about your
virtual client:
Name and Location – Specify a name for the deployed template and a location where virtual machine files
are stored.
Host / Cluster – Select the host or cluster on which you want to run the template.
Resource Pool – Select the resource pool within which you want to deploy the template.
Storage – Select a location to store virtual machine files.
Disk Format – Select the format that virtual disks will use.
Network Mapping – Select the network for the virtual machine to use. Ensure that you select the virtual
machine network associated with the IP pool you created.
7.Click Next, review the deployment summary and click Finish. The process will automatically create a virtual
machine with the settings you specify.
8.Once the ESET PROTECT VA is successfully deployed, power it on. The following information will be
displayed:

Open your web browser and enter the IP address of your newly deployed ESET PROTECT Appliance in the address
bar. You can see the IP address listed in the console window (as shown above). It will say "First time appliance
configuration needs to be performed. Please connect using a web browser to: https://[IP address]".
The next step is to configure your appliance via the web interface.
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Important
If you do not have a DHCP server in your network, you will need to Set static IP address for the ESET
PROTECT VA via Management console. If there is no IP address assigned, the following information
will be displayed; the URL will not contain an IP address.
If no IP address is assigned, the DHCP server may not be able to assign one. Make sure there are
free IP addresses in the subnet where the VA is located.

Note
We highly recommend that you configure vCenter roles and permissions in such a way that VMware
users won't be able to access the ESET PROTECT virtual machine. This will prevent users from
tampering with the ESET PROTECT VM. There is no need for ESET PROTECT users to access the VM.
To manage access to ESET PROTECT, use Access Rights in the ESET PROTECT Web Console.

VMware Workstation/Player
Deploying ESET PROTECT VA in VMware Workstation/Player
We recommend that you use the latest version of VMware Player. Set the connection for the network adapter on
your VM to Bridged or NAT.
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Note
Port forwarding must be configured on your virtual machine for ESET PROTECT to be accessible
from the network.
1.Select File > Deploy OVF Template.
2.Navigate to the protect_appliance.ova file that you downloaded from the ESET website and click Open.
3.Provide a name and local store path for the new virtual machine and click Import.
4.Read and accept the End User License Agreement (EULA) if you agree with it.
5.Once the appliance is deployed, power it on. The following information will be displayed:

Open your web browser and enter the IP address of your newly deployed ESET PROTECT Appliance in the address
bar. You can see the IP address listed in the console window (as shown above). It will say "First time appliance
configuration needs to be performed. Please connect using a web browser to: https://[IP address]".
The next step is to configure your appliance via the web interface.
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Important
If you do not have a DHCP server in your network, you will need to Set static IP address for the ESET
PROTECT VA via Management console. If there is no IP address assigned, the following information
will be displayed; the URL will not contain an IP address.
If no IP address is assigned, the DHCP server may not be able to assign one. Make sure there are
free IP addresses in the subnet where the VA is located.

Microsoft Hyper-V
Deploying ESET PROTECT VA in Microsoft Hyper-V
1.Extract the protect_appliance.vhd.zip file (that you downloaded from ESET.com) using a utility such
as Tar or 7-Zip.
2.Launch the Hyper-V manager and connect to the appropriate Hyper-V.
3.Create a new virtual machine, (Generation 1) with at least 4 Cores and 4 GB of RAM.
4.Once the VM is successfully created, power it on. The following information will be displayed:
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Open your web browser and enter the IP address of your newly deployed ESET PROTECT Appliance in the address
bar. You can see the IP address listed in the console window (as shown above). It will say "First time appliance
configuration needs to be performed. Please connect using a web browser to: https://[IP address]".
The next step is to configure your appliance via the web interface.

Important
If you do not have a DHCP server in your network, you will need to Set static IP address for the ESET
PROTECT VA via Management console. If there is no IP address assigned, the following information
will be displayed; the URL will not contain an IP address.
If no IP address is assigned, the DHCP server may not be able to assign one. Make sure there are
free IP addresses in the subnet where the VA is located.
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Oracle VirtualBox
Deploying ESET PROTECT VA in VirtualBox
We recommend that you use the latest version of VirtualBox. Set the connection for the network adapter on your
VM to Bridged, or alternatively NAT.

Note
Port forwarding must be configured on your virtual machine for ESET PROTECT to be accessible
from the internet (if required).
1.Click File and select Import Appliance.
2.Click Browse, navigate to the protect_appliance.ova file that you downloaded from ESET.com and click
Open.
3.Click Next.
4.Review your appliance settings and click Import.
5.Read and accept the End User License Agreement (EULA) if you agree with it.
6.Once the ESET PROTECT VA is successfully deployed, power it on. The following information will be
displayed:
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Open your web browser and enter the IP address of your newly deployed ESET PROTECT Appliance in the address
bar. You can see the IP address listed in the console window (as shown above). It will say "First time appliance
configuration needs to be performed. Please connect using a web browser to: https://[IP address]".
The next step is to configure your appliance via the web interface.

Important
If you do not have a DHCP server in your network, you will need to Set static IP address for the ESET
PROTECT VA via Management console. If there is no IP address assigned, the following information
will be displayed; the URL will not contain an IP address.
If no IP address is assigned, the DHCP server may not be able to assign one. Make sure there are
free IP addresses in the subnet where the VA is located.
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Citrix
Deploying ESET PROTECT VA in Citrix:

Prerequisites
• Your IPv4 network is available in the Citrix environment. IPv6 is not supported in the ESET PROTECT VA.
• The appliance .ovf file is available on the machine where you will deploy ESET PROTECT VA.
• Pool Admin Permissions are required to import the OVF/OVA package.
• Enough storage space must be available to the deploying user, at least 100 GB.

Deployment process
1.Select File > Import.
2.Click Browse, navigate to the protect_appliance.ova file that you downloaded from the ESET website and
click Next.
3.Select the check box I accept the End User License Agreements and click Next.
4.Choose the pool or standalone server where you want to place the ESET PROTECT VA and click Next.
5.Place the imported virtual disk in a storage repository and click Next.
6.Map the virtual network interfaces by selecting the Target Network and click Next.
7.Choose to verify the digital signature (optional) and click Next.
8.Select Don't use Operating System Fixup and click Next.
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9.Select the network (the same one you selected in step 6 above) where you will install the temporary ESET
PROTECT VA used to perform the import operation and click Next.
10. Review the settings and click Finish.

The deployment process can take some time, during which the Citrix server will appear idle. Do not interrupt it.

Note
See the vendor's documentation on OVF/OVA deployment.
Once the VM is successfully created, power it on. The following information will be displayed:

Open your web browser and enter the IP address of your newly deployed ESET PROTECT Appliance in the address
bar. You can see the IP address listed in the console window (as shown above). It will say "First time appliance
configuration needs to be performed. Please connect using a web browser to: https://[IP address]".
The next step is to configure your appliance via the web interface.
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Important
If you do not have a DHCP server in your network, you will need to Set static IP address for the ESET
PROTECT VA via Management console. If there is no IP address assigned, the following information
will be displayed; the URL will not contain an IP address.
If no IP address is assigned, the DHCP server may not be able to assign one. Make sure there are
free IP addresses in the subnet where the VA is located.

ESET PROTECT Virtual Appliance configuration
The ESET PROTECT Virtual Appliance (ESET PROTECT VA) can easily be configured via its web interface. You will
need to have a DHCP server in your network so that your ESET PROTECT VA is automatically assigned an IP
address, which in turn allows you to access the ESET PROTECT VA configuration web interface.

Note
If you do not have a DHCP server in your network, you will need to Set static IP address for ESET
PROTECT VA.
Once you've deployed your ESET PROTECT Virtual Appliance VM, choose which ESET PROTECT Appliance type you
want to run. In your web browser, select the ESET PROTECT Appliance type you want your VM to run from the
drop-down menu and configure it. Click the appropriate link below to view configuration instructions for different
appliance types:
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• ESET PROTECT Server Appliance
• ESET PROTECT MDM Appliance

ESET PROTECT Server Appliance
This is the configuration page for the ESET PROTECT Server appliance. It consists of two sections, Application and
Networking properties. Complete all mandatory fields (marked in red). You can specify optional configuration
parameters if necessary.

Note
This ESET PROTECT Virtual Appliance type runs ESET PROTECT Server on a dedicated VM. This
configuration is recommended for both small business and enterprise networks.

Mandatory configuration fields for the ESET PROTECT Server Appliance:
• Password - this password is important because it will be used in the VM, ESET PROTECT database, ESET
PROTECT Server Certification Authority and ESET PROTECT Web Console.
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Although not mandatory, we recommend that you specify optional parameters. For example, domain details, DC
details, domain administrator account credentials, etc. This is useful for domain actions, such as synchronization.

Click here to view the image larger
You can also enable Apache HTTP Proxy to cache updates. Select the check box next to Enable HTTP forward
proxy to install Apache HTTP Proxy, create and apply policies (named HTTP Proxy Usage, applied on the group
All) for the following products:
oESET Endpoint for Windows
oESET Endpoint for macOS (OS X) and Linux
oESET Management Agent
oESET File Security for Windows Server (V6+)
oESET Shared Local Cache
• The policy enables HTTP Proxy for applicable products. Using default settings, the proxy host is set to the ESET
PROTECT Server's local IP address on port 3128. Authentication is disabled. You can copy these settings to other
policies to set up other products.
• Using HTTP Proxy can save a lot of bandwidth on data downloaded from Internet and improve download
speeds for product updates. We recommend that you select the check box next to Apache HTTP Proxy if you
will manage more than 37 computers from ESET PROTECT.
• You can install Apache HTTP Proxy later if you want. See ESET PROTECT Virtual Appliance FAQ for details.

Networking Properties
Scroll down to set the following network properties: Network IP Address, Network Netmask, Default Gateway,
DNS1, DNS2. All fields are optional.

Join ESET PROTECT Virtual Appliance to domain
You can configure the ESET PROTECT VA to run in a domain during initial configuration. The following settings are
mandatory to use ESET PROTECT VA on a domain:
Windows workgroup - A workgroup or NETBIOS domain name for this server, for example DOMAIN.
Windows domain - A domain for this server, for example domain.com.
Windows domain controller - A domain controller for this server. Enter the domain controller fully qualified
domain name (FQDN).
Windows domain administrator - An account used to join the domain.
Windows domain administrator password - An administrator password used to join the domain.
DNS1 - A domain name server for this virtual machine. Type the IP address of domain controller.
Review the specified configuration parameters. Make sure that the configuration is correct because additional
configuration changes cannot be made.
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Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See EULA for more information.
After you click Submit, the following information will be displayed:

Note
Do not refresh this page in your web browser, close the tab and go to your ESET PROTECT VA
console window.
Your ESET PROTECT Virtual Appliance console window will display status information. The ESET PROTECT
component versions as well as ESET PROTECT Server hostname, IP address and port number will be displayed. The
ESET PROTECT Web Console address will also be displayed in the format https://[hostname] and https://[IP
address].
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Important
We recommend that you create a snapshot or backup Virtual machine before deploying and
connecting the first ESET Management Agents.
Enter the ESET PROTECT Web Console address (as shown above) in your web browser and log into the ESET
PROTECT Web Console. Your hostname and IP address will most likely be different, those shown above are for
illustration only. Once your are logged in, you can begin using ESET PROTECT.

Note
After the first login to ESET PROTECT Web Console, we advise that you run the Operating System
Update Client Task on the computer where ESET PROTECT is installed.

ESET PROTECT MDM Appliance
This is the configuration page for the ESET PROTECT MDM Appliance. Configuration consists of two sections,
Application and Networking properties. Fill-in all mandatory fields (marked in red). You can specify other
optional configuration parameters if necessary.

Note
This ESET PROTECT Virtual Appliance type runs ESET PROTECT MDM on a dedicated VM. Suitable for
enterprise-sized networks, but can be also used for small business.

Important
Before you start configuring ESET PROTECT MDM Appliance, create a Mobile Device Connector
certificate in the Web Console of ESET PROTECT Server that will be connected to your ESET PROTECT
MDM Appliance.
You can configure ESET PROTECT MDM in two ways:
1.Configuration with Web Console credentials
Mandatory configuration fields for ESET PROTECT MDM Appliance:
• Password - this password is important because it will be used in the VM and ESET PROTECT database.
• ESET PROTECT Server Hostname - type in the ESET PROTECT Server hostname or IP address, so that ESET
PROTECT MDM can connect to ESET PROTECT Server.
• ESET PROTECT Server Port - the default ESET PROTECT Server port is 2222, if you are using a different port,
replace the default port with your custom port number.
• Web Console Port - the default Web Console port is 2223, if you are using a different port, replace the
default port with your custom port number.
• Web Console password - This password is important because you need it to access the ESET PROTECT Web
Console.
• Optionally, you can enter the Webconsole Hostname. This hostname is used by Web Console to connect to
the server. If you leave the field empty, the value will be automatically copied from ESET PROTECT Server
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Hostname.
• MDM Hostname - Type the MDM FQDN or IP address (as specified in the MDC Certificate you created in the
ESET PROTECT Web Console).
2.Configuration with Certificates usage
Mandatory configuration fields for ESET PROTECT MDM Appliance:
• Password - this password is important because it will be used in the VM and ESET PROTECT database.
• ESET PROTECT Server Hostname - type in the ESET PROTECT Server hostname or IP address, so that ESET
PROTECT MDM can connect to ESET PROTECT Server.
• ESET PROTECT Server Port - the default ESET PROTECT Server port is 2222, if you are using a different port,
replace the default port with your custom port number.
• Web Console Port - the default Web Console port is 2223, if you are using a different port, replace the
default port with your custom port number.
• Certification Authority Base64 - Paste the Certification Authority Certificate in Base64 format (see ESET
PROTECT certificates for details on how to obtain the certificate).
• Proxy Certificate Base64 - Paste Proxy Certificate in Base64 format (see ESET PROTECT certificates for details
on how to obtain the certificate). To authenticate communication between ESET PROTECT Server and MDM, a
Proxy certificate is used.
• Agent Certificate Base64 - Paste Agent Certificate in Base64 format (see ESET PROTECT certificates for details
on how to obtain the certificate).
• MDM Hostname - Type the MDM FQDN or IP address (as specified in the MDC Certificate you created in the
ESET PROTECT Web Console).

Networking Properties
Scroll down to set the following network properties: Network IP Address, Network Netmask, Default Gateway,
DNS1, DNS2. All fields are optional.
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Review the configuration parameters. Make sure the configuration is correct because additional configuration
changes are not possible.
Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See EULA for more information.
Click Submit when you are finished making changes.
After you click Submit, the following notification will be displayed:

Note
Do not refresh this page in your web browser, close the tab and go to your ESET PROTECT VA
console window.
Your ESET PROTECT Virtual Appliance console window will display its status information. You'll find ESET PROTECT
component versions as well as ESET PROTECT MDM hostname, IP address and port number. You'll also find MDM
enrollment address in format https://[hostname]:9980 and https://[IP address]:9980.
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Enter displayed MDM enrollment address (as shown above) into your web browser to confirm the Mobile Device
Connector is running correctly. Your hostname and IP address will most likely be different, those shown above are
for illustration only. If the deployment was successful, you'll see following message:

ESET PROTECT Virtual Appliance Management Console
After you have successfully deployed the ESET PROTECT VA, open Virtual Machine's terminal window. You'll see a
basic information screen of your ESET PROTECT VA and its status. This is the main ESET PROTECT VA screen. From
here, you can log into ESET PROTECT VA Management Console (also known as management mode) by pressing
Enter key on your keyboard. To enter the management mode, type your password that you specified during ESET
PROTECT VA configuration and press Enter twice. If you have not configured your ESET PROTECT VA yet, you can
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use default password eraadmin to access management mode.
Once you are logged into ESET PROTECT VA Management Console, the following configuration/management
items are available:
• Set Static IP address
• Enable/Disable remote access
• Backup database
• Restore database
• Reset after snapshot revert
• Pull database from other server
• Change VM password
• Change database password
• Rejoin domain
• Configure domain
• Factory reset

Important
Presence of the items above may vary depending on ESET PROTECT VA implementation phase and
configured Appliance type.
• Restart system - if you want to reboot your ESET PROTECT VA
• Shut down system - if you want to shut down your ESET PROTECT VA
• Lock screen - you should lock the screen to prevent other people from using your ESET PROTECT VA and
accessing its files. You can also use an Esc key to lock the screen which is even quicker. Management mode will
close and you'll see the main ESET PROTECT VA screen.
• Exit to terminal - use it if you want to access operating system's terminal. It closes ESET PROTECT VA
Appliance Management Console and enters the terminal. In order to get from the terminal back to the main
ESET PROTECT VA screen, type exit and press Enter key (you can also use logout command which has the
same effect).

Set static IP address
Manual configuration is required if your ESET PROTECT VA is not assigned an IP address by a DHCP server. Follow
the instructions below to set a static IP address manually:
1.While in the VM console main screen, press Enter on your keyboard to Enter management mode. Type
eraadmin and press Enter twice to login.
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2.Choose Set static IP address using the arrow keys and press Enter.
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3.A network configuration interactive wizard will start, asking you to set:
• Static IP address
• Network mask
• Gateway address
• DNS server address

Note
Network parameters must be entered in IPv4 dot-decimal notation, for example 192.168.1.10 (IP
address) or 255.255.255.0 (network mask).
Even if the network is configured correctly, it is not possible to ping the ESET PROTECT VA machine.
4.Press Enter to continue or Ctrl+C to stay in terminal.
ESET PROTECT VA has one network adapter by default which is sufficient, but if you add multiple network
adapters for other reasons, Set static IP address will apply to the eth0 adapter only.

Enable/Disable remote access
In order to use remote access (Webmin Management Interface and SSH), you need to enable it first.
Enter management mode by typing your password and pressing Enter twice. Select Enable/Disable remote
access using the arrow keys and press Enter.
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You can now use:
• Webmin - see Webmin Management Interface for details. Webmin uses HTTPS and runs on port 10000. To
access the Webmin interface, use the IP address listed along with the port number 10000 (https://<host
name or IP address>:10000 for example https://10.1.119.162:10000 or https://esmcva:10000).
• Remote access over SSH on port 22 (this is required to enable database pull).
The following information will be displayed on the main ESET PROTECT VA Management Console screen:
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Backup database
Backup is an absolutely vital part of a sound disaster recovery strategy. Using the Backup database feature, you'll
get your ESET PROTECT database backed up and stored in MySQL backup file named era-backup.sql located in the
root folder.

Note
An alternative to database backup is to create snapshots of the VM. It will preserve whole ESET
PROTECT VA, all its settings as well as ESET PROTECT database. However, if you restore a snapshot
of your VM, you need to run Reset after snapshot revert.

Important
We recommend that you backup your ESET PROTECT database frequently and save the backup file
on external storage. This is important because you'll have a copy of the whole ESET PROTECT
database stored elsewhere (not locally on your ESET PROTECT VA) should a disaster happen. For
example if your ESET PROTECT VA gets broken, deleted or otherwise destroyed. Having a recent
ESET PROTECT database backup, you'll be able to restore ESET PROTECT VA to the state it was in
shortly before the disaster. For detailed procedure see ESET PROTECT VA disaster recovery.
1.Enter management mode by typing your password and pressing Enter twice. Select Backup database using
the arrow keys and then press Enter.
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2.You will be prompted to type in your database root password before the database backup can begin.

Note
If you do not remember database root password, you can change it and run the database backup
again.

This process can take anywhere from a few seconds to a few hours depending on the size of your database.

Note
Always check screen for errors. If there are error messages, the database backup cannot be
considered successfully completed. Try running Backup database again.
You'll find the database backup here: /root/era-backup.sql
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Important
Download the backup file using Webmin File manager to a safe location.

Restore database
This feature will replace your current database with a database from the backup.

Note
We recommend that you have a snapshot of the VM, or a backup of the current database. This is a
fallback if you experience issues during restore.
Follow these instructions to Restore database:
1.Enter management mode by typing your password and pressing Enter twice. Select Restore database using
the arrow keys and then press Enter.

Important
Upload your era-backup.sql backup file you want to restore to the root directory using Webmin File
manager. The target era-backup.sql file will be overwritten. Skip this step if you want to restore erabackup.sql which is already in the root directory.
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Warning
Do not mix backups from different servers and different server versions. Use only era-backup.sql file
which was backed up on this same ESET PROTECT VA. However, there is one occasion when you can
restore database to a different ESET PROTECT VA, but only if it's been freshly deployed and before
its configuration.
2.You might be prompted to Enter database root password at the beginning of database restore process.
However, if you are restoring database on a freshly deployed ESET PROTECT VA which has not been configured
yet, you will not be prompted to enter password.

This process can take from a few seconds to a few hours depending on the size of your database.

Note
Always check screen for errors. If there are error messages, the database restore cannot be
considered successfully completed. Try running Restore database again.

Reset after snapshot revert
Anytime you restore a snapshot of your VM to an earlier state, you need to run Reset after snapshot revert
feature in order to force all connecting clients to synchronize their statutes with this server.
1.Enter management mode by typing your password and pressing Enter twice. Select Reset after snapshot
revert using the arrow keys and press Enter.
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2.You will be prompted to type in your database root password before the ESET PROTECT Server realm is
reset.

Pull database from other server
This feature allows you to pull the ESET PROTECT database from an existing ESET PROTECT VA running in your
infrastructure. It is only supported on the ESET PROTECT Server, not on the other components (MDM, ERA Proxy
6.x). It is convenient when upgrading your ERA/ESMC VA to the latest ESET PROTECT VA, or if you want to migrate
your ESET PROTECT VA.
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Important
• In case of migration, you need to keep your old ESET PROTECT VA accessible in order for the
hostname/IP address change policy to apply to all client computers. Otherwise, clients will not be
connecting to your new ESET PROTECT VA and keep trying to connect to the old one.
• Make sure that SSH is enabled on your old ESET PROTECT VA.
• A database pull can only be performed when moving to a newer version or the same version of
ESET PROTECT server. During the pull procedure, the database structure is updated but this process
will fail when pulling to an older server. Database pull is one of two ways how to upgrade your VA.
To perform a database pull, follow the steps below:
1.Deploy a new ESET PROTECT VA, but do not configure it yet.
2.Open the VM's console and on the main screen, press Enter on your keyboard to Enter management mode
of your newly deployed ESET PROTECT VA.
3.Type eraadmin and press Enter twice to login.

4.Select Pull database from other server using the arrow keys and press Enter.
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5.Enter database root password on the remote ESET PROTECT VA you want to pull the ESET PROTECT
database from (your old ESET PROTECT VA). If you are only using one password on your old ESET PROTECT VA,
type it here.
6.Enter connection to remote ESET PROTECT VA (SSH) - type user name (root) and your old ESET PROTECT
VA host name or IP address in the following format: root@IPaddress or root@hostname
7.If you are asked about The authenticity of host, type yes. Otherwise, ignore this step.
8.Type the VM password of your old ESET PROTECT VA and press Enter. The message Remote ERA Server
database was backed up will be displayed when backup operations are completed.

Note
The amount of time needed for backup and restore operations to complete will vary depending on
database size.
9.Type the VM password of your old ESET PROTECT VA again. You might be asked to enter the password
multiple times during copying, depending on time takes to copy the database.
10. Wait until the database is restored.
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11. If you are performing an upgrade: After a successful ESET PROTECT database pull, shutdown old ESET
PROTECT VA to decommission it.

Important
• We recommend that you keep your old ESET PROTECT VA long enough before you verify that the
new instance is functioning properly.
• We strongly recommend that you do not uninstall the old ESET PROTECT VA Server using an
uninstallation script. This will dissociate (remove) all licenses from the new ESET PROTECT VA Server
database as well. To prevent this behavior, delete the old ESET PROTECT VA Server database (DROP
DATABASE) before the uninstallation.
12. Configure your new appliance:
• Upgrade - configure your new VA exactly the same as your previous ESET PROTECT VA.
• Migration - change configuration to suit a new domain (configure or rejoin domain) or network properties,
for example, if you have moved your ESET PROTECT VA to a different network.

Note
Make sure all data is preserved, all clients are connecting to your new server and your ESET
PROTECT VA behaves the same way as the previous one.
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Change VM password
Your VM password is used to log on to your deployed ESET PROTECT Virtual Appliance. If you want to change your
VM password or keep your VM more secure, we recommend that you use strong passwords and change them
regularly.

Important
This procedure will change your password for the Virtual Machine only. Your ESET PROTECT Web
Console and Database root password will not be changed. For more information, see ESET PROTECT
VA password types.

Note
If you have forgotten your password, see How to recover a forgotten ESET PROTECT VA password.
1.Enter management mode by typing your password and pressing Enter twice. Select Change VM password
using the arrow keys and press Enter.

2.Type your New password into the empty field, press Enter and then Retype it to confirm.
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The message all authentication tokens updated successfully will be displayed when you are finished and your
New password will now be required to log in.

Change database password
The database root password allows full access to the MySQL database server. The MySQL root user has
complete control over the MySQL server only.
1.Enter management mode by typing your password and pressing Enter twice. Select Change database
password using the arrow keys and press Enter.
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2.When you are prompted to Enter old database root password enter the password you set during ESET
PROTECT Virtual Appliance configuration. This password may be different from your VM password if you have
changed it separately.

Now the database root password has been changed.

Rejoin domain
Use this feature if you experience problems with Active Directory or trust relationships with the domain.

Important
It is necessary to have domain configured correctly, otherwise Rejoin domain might not work.
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1.Enter management mode by typing your password and pressing Enter twice. Select Rejoin domain using the
arrow keys and press Enter.

2.Type the domain user name that will be used to join the domain.
If you are not familiar with Linux and terminal, you can access the Webmin and use the Bind to Domain feature of
Samba Windows File Sharing.
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Configure domain
If the domain join operation fails, it is usually due to incorrect configuration of the ESET PROTECT VA files.
Configure Domain allows you to modify configuration files to include specific settings of your environment. The
following configuration files are available:
File name
/etc/hosts

Description
The Hosts file should correctly map to your domain controller name and its IP address.
The Kerberos configuration file should be correctly generated. Verify that kinit <user/etc/krb5.conf
from-domain> works.
/etc/ntp.conf
The NTP configuration file should contain a record for regular time updates against the
domain controller.
/etc/samba/smb.conf The Samba configuration file should be correctly generated.
These files are preconfigured and require minimal changes to them when specifying a domain name, for
example, or a domain controller name, a DNS server name, etc.
1.Enter management mode by typing your password and pressing Enter twice. Select Configure domain using
the arrow keys and press Enter.

Note
This is an advanced procedure that we recommend for expert administrators only.
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2.Press Enter to edit the first configuration file.
3.Press Ctrl+X to close the text editor. You will be prompted to save changes, press Y to save or N to discard. If
you have not made any changes, the text editor will just close. If you want to make further changes, do not
use Ctrl+X, but press Ctrl+C to cancel and return to the text editor. Visit this Knowledgebase article to view
examples of how to edit the configuration files.

Note
• See /root/help-with-domain.txt on your ESET PROTECT VA, the easiest way is to search for helpwith-domain.txt using Webmin File manager. Alternatively, you can use nano help-withdomain.txt command to see the help file.
• If you are not familiar with Linux and terminal, you can configure domain connection (Kerberos,
NTP or network settings through Samba Windows File Sharing) using Webmin.
4.After completing the domain configuration, select Rejoin Domain and type the Administrator name and
password for domain connection.

Factory reset
You can use Factory reset to restore your ESET PROTECT Virtual Appliance to its original state as when freshly
deployed. All of the configuration and settings will be reset and the whole ESET PROTECT database will be
dropped.
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Warning
We highly recommend that you back up your ESET PROTECT database before executing a Factory
reset. Your database will be empty after performing a reset.
Factory reset will only restore settings that were changed during ESET PROTECT VA configuration,
other changes and settings will remain. In rare cases, Factory reset will not completely restore your
VA's original state. If you are experiencing issues with ESET PROTECT VA, we recommend that you
deploy a new machine. Follow the steps to perform upgrade/migration or perform a disaster
recovery procedure.
1.Enter management mode by typing your password and pressing Enter twice. Select Factory reset using the
arrow keys and press Enter.

2.Press Enter to execute Factory reset of your ESET PROTECT VA or you can exit to menu by pressing Ctrl+C at
this point.

Warning
Once the Factory reset is running, do not press Ctrl+C, as it may do damage to your virtual
appliance.
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Note
If you see any error messages on screen during the Factory reset, try running the reset again. If rerunning the Factory reset does not help or if you are not sure, we recommend that you do a fresh
deployment, you can follow the same steps as described in upgrade/migration or perform a disaster
recovery procedure.
Factory reset performs the following actions:
• resets network configuration, all passwords and a hostname
• clears Webmin, appliance configuration files, packages and system logs
• removes all data from ESET PROTECT database
• resets ESET PROTECT database user password
After your ESET PROTECT VA reboots, it will be in its original state as if freshly deployed and ready for you to
begin configuring it from scratch.

Note
Custom modifications or settings not related to ESET PROTECT will remain unchanged.

Webmin Management Interface
Webmin is a third-party web based interface that simplifies the process of managing a Linux system. Webmin was
written for use by people who have some Linux experience, but are not familiar with the intricacies of system
administration. It lets you perform these tasks through an easy to use web interface and automatically updates all
of the required configuration files for you. This makes the job of administering your system much easier.
• Webmin is accessible through a web browser, you can log in to it from any system (client computer or a
mobile device) that is connected to your network. It is easier to use over the network than locally using other
graphical configuration programs.
• All recent versions of Webmin may be freely distributed and modified for commercial and non-commercial
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use. You can find more information on the Webmin web pages.

Important
Webmin is included in your ESET PROTECT Virtual Appliance. To begin using it, you must enable it. It
uses HTTPS and runs on port 10000. The IP address for Webmin will be shown in the ESET PROTECT
VA Management Console screen.
To access Webmin:
Open your web browser and enter the IP address or hostname of your deployed ESET PROTECT VA in the address
bar and use port 10000. The URL should be in the following format: https://<host name or IP address>:10000 for
example https://10.1.119.162:10000 or https://esmcva:10000.
Enter username and password:
othe user name is root
othe default password is eraadmin, but if you've already changed it, use the password you specified
during ESET PROTECT VA configuration.

After a successful login, the Webmin Dashboard will be displayed.

Dashboard
Once you are logged into Webmin, the Dashboard will display System Information for your ESET PROTECT VA.
Information such as hostname, OS, system uptime, memory usage, package updates, etc. Also, you'll see a
notification area at the bottom of the page where items that require your attention will be displayed. For example
a notification that a newer Webmin version is available allowing you to take action by pressing Upgrade Webmin
Now button. We recommend that you upgrade it. Once the upgrade is finished, a message Webmin install
complete is displayed.
The main menu includes the module categories: Webmin, System, Servers, Others, Networking, Hardware and
Cluster. For more information about modules see Webmin Modules pages.
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Note
The Webmin automatically detects what is configured in the VA and shows relevant modules
accordingly.
The most important modules for managing your ESET PROTECT VA are:
System
Servers
Others
Networking

Important
Webmin runs with full Linux root privileges, which means that it can edit any file and run any
command on your system. It is possible to delete all of the files on your system or make it
unbootable if you make a mistake. For this reason it is important that you use caution while running
Webmin. Even though Webmin will usually warn you before performing a potentially dangerous
action, do not make configuration changes to items you are not familiar with.

Notification - if there is something Webmin wants you to be notified of, a notification will be displayed at the
bottom of the Dashboard.
Logout - when you are done using Webmin, use the logout icon
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from the menu on the left.

System
In this section you can configure some System modules.
Bootup and Shutdown - allows you to manage services, modify, Start/Stop/Restart each service or multiple
services at the same time. You can also create and edit scripts that run at bootup and shutdown, etc. You can
Reboot or Shutdown the ESET PROTECT VM using the buttons at the bottom of the page.

Change Passwords - allows you to change VM's OS user's passwords.

Important
Do not use this when you want to change password to ESET PROTECT VA or to ESET PROTECT
database, use Change VM password or Change database password from within ESET PROTECT VM
Appliance Management Console
Running Processes - you can manage all Running processes on your system using Webmin. This module can be
used to view, kill, re-prioritize and run processes on your system.
Software Package Updates - shows you available updates and lets you update all or selected packages.
System Logs - use it to view log files on your system and, if necessary, change the location where log messages are
recorded.
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Servers
In this section you can configure some Servers modules:
Apache Webserver - is one of the most complex and powerful Webmin modules as it allows you to configure
almost every feature of Apache. You can use it as an HTTP server to serve installation files or updates. You need
to configure Firewall by adding rules to enable respective ports.

Note
This is not the same as Apache Webserver for ESET PROTECT Web Console, but you can use this
Apache Webserver for any other purpose if required.
ESET PROTECT - this module lets you Run diagnostic tool, Reset ESET PROTECT Server Administrator password,
Repair ESET PROTECT Server certificate and Certification Authority, Repair ESET Management Agent certificate
and Certification Authority, Repair ESET Management Agent connection or Edit Apache Tomcat server.xml to
change Web Console HTTPS certificates and cipher algorithms.
MySQL Database Server - allows you to manage user permissions, change password or view database content.

Important
Do not use MySQL Database Server to backup or restore the ESET PROTECT database, use ESET
PROTECT Virtual Appliance Management Console. See Backup database for details.
Samba Windows File Sharing - allows you to specify directories to be shared to Windows clients using the SMB
(Server Message Block) protocol. You can configure Samba to make files on your ESET PROTECT VA available to
Windows clients if necessary. You can also configure and join a Windows domain. If shares are enabled, Samba
ports need to be enabled in the firewall.
SSH Server - this module is used to configure SSH and OpenSSH servers, and assumes that you have a basic
knowledge of the client programs as a user. You can configure SSH Server and clients on your system.

ESET PROTECT
The ESET PROTECT module allows you to run certain pre-defined commands, mostly to Repair ESET PROTECT
certificates, Run a diagnostic tool or to Reset ESET PROTECT Server password.
Run Diagnostic Tool - click the button to extract logs and information from the system. Logs will be exported for
ESET PROTECT Server and ESET Management Agent. You can use the File Manager module to find and download
exported diagnostic log files compressed in a .zip format.

Reset ESET PROTECT Server Administrator Password - if you have forgotten your ESET PROTECT Server password
or just wish to reset the password, enter your new password for ESET PROTECT Server Administrator account and
press the button to run the command.
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Repair ESET PROTECT Server Certificate - repairs ESET PROTECT Server certificate with new PFX/PKCS12
certificate. Click the paper clip icon and browse for ESET PROTECT Server PFXor PKCS12 certificate file, then click
Open. Enter ESET PROTECT Server certificate password and press the button to run the command.

Repair ESET PROTECT Server Certification Authority - repairs ESET PROTECT Server Certification Authority with
DER certificate. Click the paper clip icon and browse for CA .der certificate file, then click Open.

Repair ESET Management Agent Connection - repair ESET Management Agent connection to ESET PROTECT
Server. Type your ESET PROTECT Server Hostname and port number, then press the button to run the command.

Repair ESET Management Agent Certificate - repairs ESET Management Agent certificate with new PFX/PKCS12
certificate. Click the paper clip icon and browse for ESET Management Agent PFX or PKCS12 certificate file, then
click Open. Enter ESET Management Agent certificate password and press the button to run the command.

Important
The certificate passphrase must not contain following characters: " \ These characters cause
critical error during the initialization of the Agent.

Repair ESET Management Agent Certification Authority - repairs ESET Management Agent Certification Authority
with DER certificate. Click the paper clip icon and browse for CA .der certificate file, then click Open.

Edit Apache Tomcat server.xml - you can edit Apache Tomcat server.xml configuration file to change Web
Console HTTPS certificates and cipher algorithms. Once you press the button, a text editor will open and let you
edit the /etc/tomcat/server.xml file. Click Save button to save changes. If a restart is necessary, it will be
done automatically. If you do not want to save changes you've made, click Return to commands.
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Others
This category of Webmin contain number of different modules. There are two very useful modules:
File Manager - lets you view and manipulate files on the server through an HTML interface. When you first load
the File manager (also known as Filemin), contents of the root directory on your ESET PROTECT VA will be shown,
depending on which user you are logged in as.
• Navigation within the directory structure is simple, click the directory name or its icon (folder). You'll see
current directory at the upper left part of the Filemin window, click any part of the path to show contents of
that particular directory.
• The Filemin can also be used to search for files, click Tools in the toolbar (at the upper right corner of the
Filemin window) and select Search. In the Search query field, enter a search pattern to look for.
• If you want to download a file from your ESET PROTECT VA to the computer your web browser is running
on, just click the file name or its icon.
• If you want to upload a file from the computer your web browser is running on, click File then Upload to
current directory. This will open a dialog window, click the paperclip icon to browse for file(s) you want to
upload. You can select multiple files and upload them by clicking the Upload Files button. Uploaded file(s)
will be stored in your current directory. Once the upload is complete, the directory list will be updated and
you will see the file(s) you've uploaded.
• You can also retrieve a file from a remote URL. To do that, click File and select Get from URL.
• The contents of any file on your system can be displayed and edited by clicking the Edit icon in the Actions
column.
• To create new empty text file, click File then Create new file, type name of the new file.
• To rename a file or directory, click the Rename icon in the right-click context menu.
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Upload and download - is another useful module of Webmin in the Others category. It allows you do three
different file actions:
• Download from web - enter URL(s) of the file(s) you want to download from the internet to your ESET
PROTECT VA and specify location where you want to store the file(s).
• Upload to server - click the paperclip icon(s) to browse for file(s) you want to upload, you can upload up to
4 files at the time. Specify location where you want to store the file(s).
• Download from server - specify path including the file name in the File to download text field or click the
icon next to it to browse ESET PROTECT VA file system for the file you want to download to the computer
your web browser is running on. Click Download button to start downloading the file, you can download one
file at a time.

Networking
You do not need to change networking settings most of the time, but if it is required, you can do so in Networking
category. In this section you can configure some of the useful modules:
Kerberos5 configuration - it is necessary to have Kerberos tickets configured correctly in order for AD
synchronization. You can run Rejoin domain once Kerberos tickets are configured.
Linux Firewall - Firewall based on IPtables. If you need to allow ports, you can do so here by adding rules or edit
existing rules.
Network configuration - you can configure network adapter, change IP address, hostname, DNS and other
network settings.
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Note
Once you are finished with configuration, press Apply Configuration button in order for the changes
to take place.

Important
This is for advanced administrators only. If the network configuration is incorrect, it may make your
system inaccessible via the network and cut off access to Webmin. However, you'll still be able to
access ESET PROTECT VA Management Console via the Virtual Machine's terminal window.

ESET PROTECT certificates
ESET PROTECT certificates are required to deploy the ESET PROTECT MDM ESET PROTECT Appliance types.
Certificates for ESET PROTECT components are available in Web Console.
To copy the contents of a certificate in Base64 format:
1.Click More > Peer Certificates.
2.Select a certificate and then select Export as Base64. You can also download the Base64 encoded certificate
as a file.
Repeat these steps for other component certificates as well as for your Certification Authority.
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Note
To export a certificate, a user is required to have Use rights over Certificates. See the full list of
access rights for more information.

ESET PROTECT VA upgrade/migration
For upgrading or migrating your VA, you can perform the following:
• Upgrade - install a newer version of ESET PROTECT components.
• Migration - move the ESET PROTECT Virtual Appliance to another instance of the same version.
• Migration & upgrade - move the ESET PROTECT Virtual Appliance to another instance of the higher
version.

Before upgrade/migration
Always backup your database and export Certification Authority and Peer Certificates from your old
ERA/ESMC/ESET PROTECT VA before migration or upgrade of the ESET PROTECT Server.
If you are upgrading/migrating from ERA 6.x, be aware of the following:
• ERA 6.x Proxy component is deprecated. Click here to read more about the HTTP Proxy new solution.
• NTLM authentication is deprecated, ESET PROTECT uses Kerberos instead. You have to use the Linux
login format, if you are logging in to domain on ESET PROTECT VA. This also applies to synchronization
tasks.
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Database pull versus the Components Upgrade
There are two principal ways of upgrading your VA:
• Using the database pull - upgrades your whole Appliance (the underlying operating system), not just the
ESET PROTECT Server. The process is more complicated and requires having two concurrent appliances
during the transition period. The database pull is recommended for major version upgrades or as a
troubleshooting method.
• Upgrading via Components Upgrade task in the Web Console - the process is more simple and does not
require access to the appliance, only to the Web Console. It is recommended for minor and hot fix upgrades.

Migration and upgrade process (recommended way to upgrade)
Use the following instructions to migrate and upgrade your ESET PROTECT VA.
1.Download the latest version of protect_appliance.ova (or protect_appliance.vhd.zip if you
use Microsoft Hyper -V).
2.Deploy new ESET PROTECT VA. See ESET PROTECT Appliance deployment process for instructions. Do not
configure the new ESET PROTECT VA via its web interface yet.
3.Pull database from your old VA, see Pull database from other server for a complete step-by-step guide.

Important
Do not uninstall/decommission your old VA Server yet.
4.Configure ESET PROTECT Virtual Appliance via its web interface.
5.Verify that your new ESET PROTECT VA behaves the same way as the previous one:
oIf the new ESET PROTECT VA has a different IP address:
a)Create a policy on your old VA to set a new ESET PROTECT Server IP address and assign it to all
computers.
b)Wait for the policy to distribute to all ESET Management Agents.
c)Make sure all computers are connecting to the new ESET PROTECT VA.
d)Turn off and decommission the old VA.

Important
We strongly recommend that you do not uninstall the old ESET PROTECT VA Server using an
uninstallation script. This will dissociate (remove) all licenses from the new ESET PROTECT VA Server
database as well. To prevent this behavior, delete the old ESET PROTECT VA Server database (DROP
DATABASE) before the uninstallation.
oIf the new ESET PROTECT VA has the same IP address:

Important
Make sure the network configuration on your new ESET PROTECT Server (IP address, FQDN,
Computer name, DNS SRV record) matches that of your old VA Server. You can also use the
hostname by changing the DNS record to point to the new server.
a)Turn off the old VA.
b)Turn on the new ESET PROTECT VA.
c)Make sure all computers are connecting to the new ESET PROTECT VA.
d)Decommission the old VA.
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Important
We strongly recommend that you do not uninstall the old ESET PROTECT VA Server using an
uninstallation script. This will dissociate (remove) all licenses from the new ESET PROTECT VA Server
database as well. To prevent this behavior, delete the old ESET PROTECT VA Server database (DROP
DATABASE) before the uninstallation.
6.Upgrade a ESET Management Agents sample group using an ESET PROTECT Components Upgrade task.
7.If the upgrade of the sample is successful and Agents are still connecting, continue with the rest of the
Agents.

Upgrade process (an alternative way to upgrade)
Important
Upgrading ERA/ESMC or older ESET PROTECT to the latest ESET PROTECT on the same VA does not
upgrade other VA software (operating system, packages needed for proper functioning of ESET
PROTECT Server). We recommend that you migrate the server after the pure upgrade.
Upgrade the VA using a Components Upgrade task:
1.Upgrade the ESET PROTECT Server first.
2.Upgrade a ESET Management Agents sample group.
3.If the upgrade of the sample is successful and Agents are still connecting, continue with the rest of the
Agents.

ESET PROTECT VA disaster recovery
In case of an unfortunate event in which your ESET PROTECT VA gets broken and you're not able to start it again,
or even if it is deleted from storage or otherwise destroyed, you can follow disaster recovery procedure.

Note
It is necessary that you have your ESET PROTECT VA's database backup for successful recovery.
1.Download the latest version of protect_appliance.ova, or protect_appliance.vhd.zip if you use
Microsoft Hyper-V. The advantage of this recovery procedure is that your ESET PROTECT VA will be up to date.
2.Deploy new ESET PROTECT VA, but do not configure it yet. See ESET PROTECT Appliance deployment
process for instructions.
3.Enable Webmin in order to be able to upload MySQL backup file, for details how to enable it see
Enable/Disable remote access section.
4.Restore database from the latest backup file you have, follow the steps described in Restore database
section.
5.Configure your freshly deployed ESET PROTECT VA with restored database the same way as your previous
VA, see ESET PROTECT VA configuration for details.
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Troubleshooting
The following log files can be used to troubleshoot the ESET PROTECT Virtual Appliance. Also, you may be asked
by ESET technical support to provide diagnostic logs. These are the log files you can send for analysis:
Log name
ESET PROTECT VA
configuration

Location
/root/appliance-configuration-log.txt

Description
If your ESET PROTECT VA
deployment fails, do not
restart the appliance and check
configuration log file.
ESET PROTECT Server /var/log/eset/RemoteAdministrator/EraServerInstaller.log ESET PROTECT Server
/var/log/eset/RogueDetectionSensor/RDSensorInstaller.log installation log file.
Other ESET PROTECT
components use a similar path
and corresponding file name.
ESET PROTECT Server /var/log/eset/RemoteAdministrator/Server/
Check your trace logs:
trace log
/var/log/eset/RemoteAdministrator/Agent/
trace.log
ESET Management
status.html
Agent trace log
last-error.html
Other ESET PROTECT
components use similar path
and file names.
Apache HTTP Proxy /opt/apache/logs/
log file for older versions of
/var/log/httpd
ESET PROTECT Virtual
Appliance
log file for newer versions of
ESET PROTECT Virtual
Appliance
ESET PROTECT Server /var/opt/eset/RemoteAdministrator/Server/Dumps/
crash dumps
ESET PROTECT Server /root/RemoteAdministratorAgentDiagnostic.zip
If you experience issues with
or ESET Management
your ESET PROTECT VA, you
Agent run diagnostic
can Run diagnostic tool, see
tool
ESET PROTECT Webmin
module for details.
If the Server or Agent are crashing and you cannot change the logging verbosity via Web Console, you can enable
full trace logging by creating the empty file:
For Agent:
touch /var/log/eset/RemoteAdministrator/Agent/traceAll

For Server:
touch /var/log/eset/RemoteAdministrator/Server/traceAll

Note
We recommend that you use Webmin File manager where you can easily search for files and
download logs if necessary.
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ESET PROTECT Virtual Appliance FAQ
This chapter covers some of the most frequently asked questions and problems encountered. Click the topic title
to find out how to solve your problem:
• How to find out which ESET PROTECT components are installed
• How to enable ping on ESET PROTECT Virtual Appliance
• Do I need to add other components to my ESET PROTECT VA?
• How to enable Apache HTTP proxy on my ESET PROTECT Virtual Appliance after initial configuration
• How to configure LDAP to allow for Static Group synchronization on ESET PROTECT VA
• Configure LDAPS connection to a domain
• How to recover forgotten password for ESET PROTECT VA
• How to change ESET PROTECT database connection string
• How to set up Hyper-V Server for RD Sensor
• How to change port numbers for ESET PROTECT Virtual Appliance
• How to increase memory size for MySQL Server
• Error with ESET PROTECT running on a Hyper-V Server 2012 R2
• How to improve Oracle VirtualBox performance
• How to enable YUM command under HTTP proxy
• How to update operating system on machine running ESET PROTECT VA Server
• How to disable SELinux permanently
• How to restart Virtual Appliance Management Console
• How to use Proxy for Agents' connections
• How to enable Hardware Inventory on older Virtual Appliances (6.x)
• How to enable SSH
If your problem is not included in the help pages list above, try searching by keyword or phrase describing your
problem and search within the ESET PROTECT Help Pages.
If you cannot find the solution to your problem/question within the Help Pages, you can try our regularly updated
online Knowledgebase.
If necessary, you can directly contact our online technical support center with your questions or problems. The
contact form can be found in the ESET PROTECT Web Console > Help > Contact Support.

How to find out which ESET PROTECT components are
installed
A list of installed ESET PROTECT components and their versions is available in the console window of your ESET
PROTECT Virtual Appliance. If you want to refresh this dialog after components upgrade, you can reboot VA,
alternatively, Enter management mode and select Exit to terminal, then exit the terminal to return back to lock
screen.
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How to enable ping on ESET PROTECT Virtual Appliance
Open terminal and run the following commands as root to enable ping on an ESET PROTECT Virtual Appliance
machine.
Before you start, check which version of CentOS is running on your system with the command hostnamectl.
Then run the following commands according to your OS version.

For CentOS 7
1. Call the iptables command:
iptables -A INPUT -p icmp --icmp-type echo-request -j ACCEPT

2. Save iptables:
service iptables save

Now it is possible to ping ESET PROTECT Virtual Appliance from other computers located in the same subnet.
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Do I need to add other components to my ESET
PROTECT VA?
No, ESET PROTECT Virtual Appliance runs out of the box. You just need to deploy the appliance and configure it.
It's truly the simplest way to deploy ESET PROTECT as long as you use a supported hypervisor.

How to enable Apache HTTP Proxy on my ESET
PROTECT Virtual Appliance after initial configuration
Open terminal and according to your OS version run the following commands as root to enable Apache HTTP
Proxy:

Note
• The location of apachectl and htcacheclean will vary based on your system, check it before
running the script.
• The parameter /var/cache/httpd/proxy determines the location of the caching folder, this
location is set in /etc/httpd/conf.d/proxy.conf under CacheRoot.
• Apache HTTP Proxy replaces the Mirror Tool functionality from ESET Remote Administrator 6.x. It
is primarily used for caching detection engine update files and caching information from ESET
LiveGrid®.

For CentOS 7
1. systemctl enable httpd
2. sudo mkdir -p /etc/systemd/system/httpd.service.requires
3. sudo ln -

s /usr/lib/systemd/system/htcacheclean.service /etc/systemd/system/httpd.service.r
equires

4. systemctl start httpd
5. htcacheclean -d60 -t -i -p/var/cache/httpd/proxy -l10000M

Note
You can adjust parameters for Apache HTTP Proxy cache cleaning: -d defines cleaning interval in
minutes, -p specifies path as the root directory of the disk cache, -t deletes all empty directories, i intelligently deletes cache only when there was a modification of the disk cache, -l defines total
disk cache size limit.
6. iptables -A INPUT -p tcp --dport 3128 -j ACCEPT
7. ip6tables -A INPUT -p tcp --dport 3128 -j ACCEPT
8. service iptables save
9. service ip6tables save
This will start Apache HTTP Proxy and enable port 3128 in a firewall. You will need to create policies for all ESET
products / ESET PROTECT components to communicate via Apache HTTP Proxy and allow the caching of
installation files / update files for ESET products. Make sure, the Apache configuration contains the ProxyMatch
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segment for your server host. For more information see our Knowledgebase article part II. Configure policy
settings for client computers.

How to configure LDAP to allow for Static Group
synchronization on ESET PROTECT VA
If the domain join operation fails, it is usually due to incorrect configuration of the ESET PROTECT VA, for more
information see our Knowledgebase article.

Configure LDAPS connection to a domain
ESET PROTECT Server on Windows uses the encrypted LDAPS (LDAP over SSL) protocol by default for all Active
Directory connections.
Follow the steps below to configure ESET PROTECT Virtual Appliance to connect to Active Directory via LDAPS.

Prerequisites
• Set up LDAPS on the Domain Controller - make sure to export the DC Certification Authority public key.
• Make sure Kerberos is correctly configured on your ESET PROTECT VA

Enable LDAPS on ESET PROTECT VA
1.Open virtual machine's terminal window with ESET PROTECT VA.
2.Press Enter, type your password that you specified during ESET PROTECT VA configuration and press Enter
twice.
3.Select Exit to terminal and press Enter.
4.Stop the ESET PROTECT Server service:
systemctl stop eraserver

5.Type the following command:
nano /etc/systemd/system/eraserver.service

6.Add the following line to the [Service] section:
Environment="ESMC_ENABLE_LDAPS=1"

7.Press CTRL+X and type Y to save the file changes. Press Enter to exit the editor.
8.Run the following command to reload the configuration:
systemctl deamon-reload

9.Start the ESET PROTECT Server service:
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systemctl start eraserver

10. Copy the certificate file you generated on the Domain Controller to the following location on your ESET
PROTECT VA Server:
/etc/pki/ca-trust/source/anchors/

11. Run the following command:
update-ca-trust

How to recover a forgotten password for ESET PROTECT
VA
Start your ESET PROTECT VA in a Single-User Mode. For instructions, visit the CentOS 7 documentation. If you
have upgraded from an ERA VA to an ESET PROTECT VA and it is running CentOS 6, visit the CentOS 6
documentation. Once you are in the shell in Single-User Mode, change your root password using the passwd
command.
If you receive the “passwd: Authentication token manipulation error”, follow these troubleshooting
steps.

How to change ESET PROTECT database connection
string
You can change the ESET PROTECT database connection string on your ESET PROTECT VA by editing the
StartupConfiguration.ini file.
To change the ESET PROTECT database connection string, follow the instructions below:
1.Enter management mode by typing your password and pressing Enter twice. Select Exit to terminal using
the arrow keys and then press Enter.
2.Type:
nano /etc/opt/eset/RemoteAdministrator/Server/StartupConfiguration.ini

3.Edit data in the ESET PROTECT database connection string.
4.Press Ctrl+X and y to save the changes.

How to set up Hyper-V Server for RD Sensor
Make sure that MAC address spoofing is enabled in your Hyper-V Manager settings (see below).
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How to change port numbers for ESET PROTECT Virtual
Appliance
In order to change port number(s), do the following changes for relevant ESET PROTECT component:
ESET PROTECT Web Console port (default 8443)
1.Open Webmin, navigate to Servers > ESET PROTECT > Edit Apache Tomcat server.xml and modify line
<Connector port="8443"

2.Edit the /var/lib/tomcat/webapps/era/WEBINF/classes/sk/eset/era/g2webconsole/server/modules/config/EraWebServerConfig.properties and set
server_port= to your value.
3.Restart the Tomcat service
systemctl restart tomcat
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ESET PROTECT Server ports (default 2222, 2223) - log into ESET PROTECT Web Console, navigate to More > Server
Settings > Connection and change as needed.

Important
If you've changed any of the ports above, you need to modify Firewall settings as well. Open
Webmin, navigate to Networking > Linux Firewall and change port numbers in existing rules.
Alternatively, you can add new rules.

How to increase memory size for MySQL Server
To increase the memory size for a MySQL Server, follow these steps:
1.Enter management mode by typing your password and pressing Enter twice. Select Exit to terminal
using the arrow keys and then press Enter.
2.Type:
nano /etc/my.cnf

3.Locate the line innodb_buffer_pool_size = 1024M and change the number to 50% of RAM of the
VM. 1024M means 1024 megabytes.
4.Press Ctrl+X to exit the text editor, then press Y to save.
5.Reboot the appliance using the Restart system option in management mode.

Error with ESET PROTECT running on a Hyper-V Server
2012 R2
After logging into ESET PROTECT Web Console, the error message "Unable to handle Kernel NULL pointer
dereference at (null)" is displayed.
Disable Dynamic memory in virtual computer settings to resolve this issue.

How to improve Oracle VirtualBox performance
You can change number of processors (CPU cores) in Settings of ESET PROTECT Virtual Appliance. Go to System >
Processor tab. Lower the number of processors for the VA. For example, if you have 4 physical CPUs, change the
setting to let the VA use only 2 processors.

How to enable YUM command under HTTP Proxy server
If you have a local network that uses a proxy server as intermediary for internet access, yum command may not
be configured properly and might not work.
To configure yum to work with proxy:
1.Enter management mode by typing your password and pressing Enter twice. Select Exit to terminal using
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the arrow keys and then press Enter.
2.Type:
nano /etc/yum.conf

3.Add a line with with information about your proxy. For example:
proxy=http://proxysvr.yourdom.com:3128

4.If the proxy requires username and password, add these settings. For example:
proxy=http://proxysvr.yourdom.com:3128
proxy_username=YourProxyUsername
proxy_password=YourProxyPassword

5.Press Ctrl+X and y to save the changes.

Important
Keep in mind, /etc/yum.conf must be readable for all to work with yum command. Therefore
your proxy password can be read by other users. Do not use the same password anywhere else.
For more information, read the official vendor's documentation.

How to update the operating system on a machine
running ESET PROTECT VA Server
If ESET PROTECT Web Console shows a warning that the ESET PROTECT VA Server Operating system is not up to
date, you need to update the ESET PROTECT VA Server operating system. Run the Operating System Update task
from the ESET PROTECT Web Console. After the update is finished, the warning message will disappear.

Important
If the operating system update is performed from the Webmin interface, from terminal, or by a
third-party tool, the warning message will not disappear even after the operating system has been
updated. In this scenario, we recommend that you run the Operating System Update task from the
ESET PROTECT Web Console.

How to disable SELinux permanently
SELinux is enabled by default in the virtual appliance. To switch it off permanently, follow these steps:
1.Select Exit to Terminal from the Virtual Appliance Management Console.
2.Run the command:
nano /etc/selinux/config

3.Change the line:
SELINUX=permisive

to
SELINUX=disabled
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4.Save the changes and exit the editor.
5.Restart the computer with the following command to apply the new setting.
reboot

How to restart Virtual Appliance Management Console
It is possible to restart the graphical interface of virtual appliance without restarting the virtual machine. This will
force refresh all data in the console. (For example, if a changed setting is not taking effect in the Virtual Appliance
Management Console.)
1.Select Exit to Terminal from the Virtual Appliance Management Console.
2.Run the command:
./appliance-gui restart

How to use Proxy for Agents connections
ESET Management Agents from version 7 are not able to connect ERA because they use a new replication
protocol. Version 6 agents can connect to the version 7 or 8 server via ERA Proxy. For migration follow the proxy
migration guidelines.
Using Proxy to forward ESET Management Agent - ESET PROTECT Server connections in the ESET PROTECT version
7 is possible via Apache HTTP Proxy. Follow the Linux instructions for Apache HTTP Proxy installation.
If you are upgrading an existing environment that currently uses the ERA 6.x Proxy component, follow the Proxy
upgrade guide.

How to enable Hardware Inventory on older Virtual
Appliances (6.x)
If you have upgraded ERA 6.x VA (CentOS) to ESET PROTECT VA, you need to install lshw on it in order to enable
the Hardware Inventory feature:
sudo yum install -y lshw

How to enable SSH
Follow the steps below to enable SSH:
• ESET PROTECT VA (or ESMC VA) - see Enable/Disable remote access
• ERA VA 6.x - SSH is enabled by default.
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SSH troubleshooting
Open the terminal and run the following commands:
• sudo service sshd status - verify that SSH is running. If SSH is not running, you can start it: service
sshd start
• sudo iptables -S - if port 22 is open, you will see the following line: -A INPUT -p tcp -m tcp -dport 22 -j ACCEPT. To add port 22 to iptables, run the command below:
sudo iptables -A INPUT -p tcp -m tcp --dport 22 -j ACCEPT

End User License Agreement
IMPORTANT: Please read the terms and conditions of product application set out below carefully prior to
download, installation, copy or use. THROUGH DOWNLOADING, INSTALLING, COPYING OR USING THE
SOFTWARE YOU ARE EXPRESSING YOUR CONSENT TO THESE TERMS AND CONDITIONS AND YOU
ACKNOWLEDGE PRIVACY POLICY.
End User License Agreement
Under the terms of this End User License Agreement (hereinafter referred to as "the Agreement") executed by
and between ESET, spol. s r. o., having its registered office at Einsteinova 24, 85101 Bratislava, Slovak Republic,
registered in the Commercial Register administered by Bratislava I District Court, Section Sro, Entry No 3586/B,
Business Registration Number: 31333532 (hereinafter referred to as "ESET" or "the Provider") and you, a physical
person or legal entity (hereinafter referred to as "You" or "the End User"), You are entitled to use the Software
defined in Article 1 of this Agreement. The Software defined in Article 1 of this Agreement can be stored on a data
carrier, sent via electronic mail, downloaded from the Internet, downloaded from the Provider's servers or
obtained from other sources, subject to the terms and conditions specified below.
THIS IS AN AGREEMENT ON END USER RIGHTS AND NOT AN AGREEMENT FOR SALE. The Provider continues to
own the copy of the Software and the physical media contained in the sales package and any other copies that
the End User is authorized to make pursuant to this Agreement.
By clicking on "I Accept" or "I Accept…" while installing, downloading, copying or using the Software, You agree to
the terms and conditions of this Agreement. If You do not agree to all of the terms and conditions of this
Agreement, immediately click on the canceling option, cancel the installation or download, or destroy or return
the Software, installation media, accompanying documentation and sales receipt to the Provider or the outlet
from which You acquired the Software.
YOU AGREE THAT YOUR USE OF THE SOFTWARE ACKNOWLEDGES THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
1. Software. As used in this Agreement the term "Software" means: (i) computer program accompanied by this
Agreement and all components thereof; (ii) all the contents of the disks, CD-ROMs, DVDs, e-mails and any
attachments, or other media with which this Agreement is provided, including the object code form of the
Software supplied on a data carrier, via electronic mail or downloaded via the Internet; (iii) any related
explanatory written materials and any other possible documentation related to the Software, above all any
description of the Software, its specifications, any description of the Software properties or operation, any
description of the operating environment in which the Software is used, instructions for use or installation of the
Software or any description of how to use the Software (hereinafter referred to as " Documentation "); (iv) copies
of the Software, patches for possible errors in the Software, additions to the Software, extensions to the
Software, modified versions of the Software and updates of Software components, if any, licensed to You by the
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Provider pursuant to Article 3 of this Agreement. The Software shall be provided exclusively in the form of
executable object code.
2. Installation, Computer and a License key. Software supplied on a data carrier, sent via electronic mail,
downloaded from the Internet, downloaded from the Provider's servers or obtained from other sources requires
installation. You must install the Software on a correctly configured Computer, complying at least with
requirements set out in the Documentation. The installation methodology is described in the Documentation. No
computer programs or hardware which could have an adverse effect on the Software may be installed on the
Computer on which You install the Software. Computer means hardware, including but not limited to personal
computers, laptops, workstations, palmtop computers, smart phones, hand-held electronic devices, or other
electronic devices for which the Software is designed, on which it will be installed and/or used. License key means
the unique sequence of symbols, letters, numbers or special signs provided to the End User in order to allow the
legal use of the Software, its specific version or extension of the term of the License in compliance with this
Agreement.
3. License. Subject to the condition that You have agreed to the terms of this Agreement and You comply with all
the terms and conditions stipulated herein, the Provider shall grant You the following rights (hereinafter referred
to as "License"):
a) Installation and use. You shall have the non-exclusive, non-transferable right to install the Software on the
hard disk of a Computer or other permanent medium for data storage, installation and storage of the Software in
the memory of a computer system and to implement, store and display the Software.
b) Stipulation of the number of licenses. The right to use the Software shall be bound by the number of End
Users. One End User shall be taken to refer to the following: (i) installation of the Software on one computer
system; or (ii) if the extent of a license is bound to the number of mail boxes, then one End User shall be taken to
refer to a computer user who accepts electronic mail via a Mail User Agent (hereinafter referred to as "MUA"). If
MUA accepts electronic mail and subsequently distributes it automatically to several users, then the number of
End Users shall be determined according to the actual number of users for whom the electronic mail is
distributed. If a mail server performs the function of a mail gate, the number of End Users shall equal the number
of mail server users for which the said gate provides services. If an unspecified number of electronic mail
addresses are directed to and accepted by one user (e.g., through aliases) and messages are not automatically
distributed by the client to a larger number of users, a License for one computer shall be required. You must not
use the same License at the same time on more than one Computer. The End User is entitled to enter the License
key to the Software only to the extent in which has the right to use the Software in accordance the limitation
arising from the number of Licenses granted by Provider. The License key is deemed confidential, You must not
share the License with third parties or allow third parties to use the License key unless permitted by this
Agreement or Provider. If your License key is compromised, notify Provider immediately.
c) Business Edition. A Business Edition version of the Software must be obtained to use the Software on mail
servers, mail relays, mail gateways or Internet gateways.
d) Term of the License. Your right to use the Software shall be time-limited.
e) OEM Software. OEM Software shall be limited to the Computer You obtained it with. It cannot be transferred
to a different Computer.
f) NFR, TRIAL Software. Software classified as "Not-for-resale", NFR or TRIAL cannot be assigned for payment and
must only be used for demonstration or testing the Software's features.
g) Termination of the License. The License shall terminate automatically at the end of the period for which
granted. If You fail to comply with any of the provisions of this Agreement, the Provider shall be entitled to
67

withdraw from the Agreement, without prejudice to any entitlement or legal remedy open to the Provider in such
eventualities. In the event of cancellation of the License, You must immediately delete, destroy or return at your
own cost, the Software and all backup copies to ESET or to the outlet from which You obtained the Software.
Upon termination of the License, the Provider shall be also entitled to cancel the End User's entitlement to use
the functions of the Software, which require connection to the Provider's servers or third-party servers.
4. Functions with data collection and internet connection requirements. To operate correctly the Software
requires connection to the Internet and must connect at regular intervals to the Provider's servers or third-party
servers and applicable data collection in compliance with Privacy Policy. Connection to the Internet and applicable
data collection is necessary for the following functions of the Software:
a) Updates to the Software. The Provider shall be entitled from time to issue updates to the Software
("Updates"), but shall not be obliged to provide Updates. This function is enabled under the Software's standard
settings and Updates are therefore installed automatically, unless the End User has disabled automatic
installation of Updates. For the purpose of provisioning of Updates, License authenticity verification is required
including information about Computer and/or the platform on which the Software is installed in compliance with
Privacy Policy.
b) Forwarding of Information to the Provider. The Software contains functions which collect data about the
installation process, the Computer and/or the platform on which the Software is installed, information about the
operations and functionality of the Software and information about managed devices (hereinafter referred to as
"Information") and then send them to the Provider. The Information may contain data (including randomly or
accidentally obtained personal data) concerning managed devices. By activating this function of the Software,
Information may be collected and processed by the Provider as specified in Privacy Policy and in compliance with
relevant legal regulations.
The Software requires a component installed on managed computer, which enables transfer of information
between managed computer and remote management software. Information, which are subject to transfer
contains management data such as hardware and software information of managed computer and managing
instructions from the remote management software. Other content of data transferred from managed computer
shall be determined by the settings of software installed on managed computer. The content of instructions from
management software shall be determined by settings of remote management software.
For the purpose of this Agreement, it is necessary to collect, process and store data enabling the Provider to
identify You in compliance with Privacy Policy. You hereby acknowledge that the Provider checks using its own
means whether You are using the Software in accordance with the provisions of this Agreement. You hereby
acknowledge that for the purpose of this Agreement it is necessary for your data to be transferred, during
communication between the Software and the Provider's computer systems or those of its business partners as
part of Provider’s distribution and support network to ensure functionality of Software and authorization to use
the Software and to protection of the Provider’s rights.
Following conclusion of this Agreement, the Provider or any of its business partners as part of Provider’s
distribution and support network shall be entitled to transfer, process and store essential data identifying You for
billing purposes, performance of this Agreement and transmitting notifications on your Computer. You hereby
agree to receive notification and messages including but not limited to marketing information.
Details about privacy, personal data protection and Your rights as a data subject can be found in Privacy Policy
which is available on Provider’s website and accessible directly from the installation process. You can also visit
it from Software’s help section.
5. Exercising End User rights. You must exercise End User rights in person or via your employees. You are only
entitled to use the Software to safeguard your operations and protect those Computers or computers systems for
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which You have obtained a License.
6. Restrictions to rights. You may not copy, distribute, extract components or make derivative works of the
Software. When using the Software, You are required to comply with the following restrictions:
a) You may make one copy of the Software on a permanent storage medium as an archival back-up copy,
provided your archival back-up copy is not installed or used on any Computer. Any other copies You make of the
Software shall constitute breach of this Agreement.
b) You may not use, modify, translate or reproduce the Software or transfer rights to use the Software or copies
of the Software in any manner other than as provided for in this Agreement.
c) You may not sell, sub-license, lease or rent or borrow the Software or use the Software for the provision of
commercial services.
d) You may not reverse engineer, reverse compile or disassemble the Software or otherwise attempt to discover
the source code of the Software, except to the extent that this restriction is expressly prohibited by law.
e) You agree that You will only use the Software in a manner that complies with all applicable laws in the
jurisdiction in which You use the Software, including, but not limited to, applicable restrictions concerning
copyright and other intellectual property rights.
f) You agree that You will only use the Software and its functions in a way which does not limit the possibilities of
other End Users to access these services. The Provider reserves the right to limit the scope of services provided to
individual End Users, to enable use of the services by the highest possible number of End Users. Limiting the
scope of services shall also mean complete termination of the possibility to use any of the functions of the
Software and deletion of Data and information on the Provider's servers or third-party servers relating to a
specific function of the Software.
g) You agree not exercise any activities involving use the License key, contrary to the terms of this Agreement or
leading to provide License key to any person who is not entitled to use the Software, such as the transfer of used
or unused License key in any form, as well as the unauthorized reproduction, or distribution of duplicated or
generated License keys or using the Software as a result of the use of a License key obtained from the source
other than the Provider.
7. Copyright. The Software and all rights, without limitation including proprietary rights and intellectual property
rights thereto are owned by ESET and/or its licensors. They are protected by international treaty provisions and
by all other applicable national laws of the country in which the Software is being used. The structure,
organization and code of the Software are the valuable trade secrets and confidential information of ESET and/or
its licensors. You must not copy the Software, except as set forth in Article 6(a). Any copies which You are
permitted to make pursuant to this Agreement must contain the same copyright and other proprietary notices
that appear on the Software. If You reverse engineer, reverse compile, disassemble or otherwise attempt to
discover the source code of the Software, in breach of the provisions of this Agreement, You hereby agree that
any information thereby obtained shall automatically and irrevocably be deemed to be transferred to and owned
by the Provider in full, from the moment such information comes into being, notwithstanding the Provider's rights
in relation to breach of this Agreement.
8. Reservation of rights. The Provider hereby reserves all rights to the Software, with the exception of rights
expressly granted under the terms of this Agreement to You as the End User of the Software.
9. Multiple language versions, dual media software, multiple copies. In the event that the Software supports
multiple platforms or languages, or if You receive multiple copies of the Software, You may only use the Software
for the number of computer systems and for the versions for which You obtained a License. You may not sell,
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rent, lease, sub-license, lend or transfer versions or copies of the Software which You do not use.
10. Commencement and termination of the Agreement. This Agreement shall be effective from the date You
agree to the terms of this Agreement. You may terminate this Agreement at any time by permanently
uninstalling, destroying and returning, at your own cost, the Software, all back-up copies and all related materials
provided by the Provider or its business partners. Irrespective of the manner of termination of this Agreement,
the provisions of Articles 7, 8, 11, 13, 19 and 21 shall continue to apply for an unlimited time.
11. END USER DECLARATIONS. AS THE END USER YOU ACKNOWLEDGE THAT THE SOFTWARE IS PROVIDED "AS
IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, AND TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW. NEITHER THE PROVIDER, ITS LICENSORS OR AFFILIATES, NOR THE COPYRIGHT HOLDERS MAKE
ANY REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR THAT THE SOFTWARE WILL
NOT INFRINGE ANY THIRD-PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS. THERE IS NO
WARRANTY BY THE PROVIDER OR BY ANY OTHER PARTY THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE
WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE. YOU ASSUME ALL RESPONSIBILITY AND RISK FOR THE SELECTION OF THE SOFTWARE TO ACHIEVE
YOUR INTENDED RESULTS AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM IT.
12. No other obligations. This Agreement creates no obligations on the part of the Provider and its licensors other
than as specifically set forth herein.
13. LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
THE PROVIDER, ITS EMPLOYEES OR LICENSORS BE LIABLE FOR ANY LOST PROFITS, REVENUE, SALES, DATA OR
COSTS OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, PROPERTY DAMAGE, PERSONAL INJURY,
INTERRUPTION OF BUSINESS, LOSS OF BUSINESS INFORMATION OR FOR ANY SPECIAL, DIRECT, INDIRECT,
INCIDENTAL, ECONOMIC, COVER, PUNITIVE, SPECIAL OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND
WHETHER ARISING UNDER CONTRACT, TORT, NEGLIGENCE OR OTHER THEORY OF LIABILITY, ARISING OUT OF THE
USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF THE PROVIDER OR ITS LICENSORS OR AFFILIATES ARE
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME COUNTRIES AND JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OF LIABILITY, BUT MAY ALLOW LIABILITY TO BE LIMITED, IN SUCH CASES, THE LIABILITY
OF THE PROVIDER, ITS EMPLOYEES OR LICENSORS OR AFFILIATES SHALL BE LIMITED TO THE SUM THAT YOU PAID
FOR THE LICENSE.
14. Nothing contained in this Agreement shall prejudice the statutory rights of any party dealing as a consumer if
running contrary thereto.
15. Technical support. ESET or third parties commissioned by ESET shall provide technical support at their own
discretion, without any guarantees or declarations. The End User shall be required to back up all existing data,
software and program facilities prior to the provision of technical support. ESET and/or third parties
commissioned by ESET cannot accept liability for damage or loss of data, property, software or hardware or loss
of profits due to the provision of technical support. ESET and/or third parties commissioned by ESET reserve the
right to decide that resolving the problem is beyond the scope of technical support. ESET reserves the right to
refuse, suspend or terminate the provision of technical support at its own discretion. License information,
Information and other data in compliance with Privacy Policy may be required for the purpose of technical
support provision.
16. Transfer of the License. The Software can be transferred from one Computer to another, unless contrary to
the terms of the Agreement. If not contrary to the terms of the Agreement, the End User shall only be entitled to
permanently transfer the License and all rights ensuing from this Agreement to another End User with the
Provider's consent, subject to the condition that (i) the original End User does not retain any copies of the
Software; (ii) the transfer of rights must be direct, i.e. from the original End User to the new End User; (iii) the
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new End User must assume all the rights and obligations incumbent on the original End User under the terms of
this Agreement; (iv) the original End User has to provide the new End User with documentation enabling
verification of the genuineness of the Software as specified under Article 17.
17. Verification of the genuineness of the Software. The End User may demonstrate entitlement to use the
Software in one of the following ways: (i) through a license certificate issued by the Provider or a third party
appointed by the Provider; (ii) through a written license agreement, if such an agreement was concluded; (iii)
through the submission of an e-mail sent by the Provider containing licensing details (user name and password).
License information and End User identification data in compliance with Privacy Policy may be required for the
purpose of Software genuineness verification.
18. Licensing for public authorities and the US Government. The Software shall be provided to public authorities,
including the United States Government, with the license rights and restrictions described in this Agreement.
19. Trade control compliance.
a) You will not, directly or indirectly, export, re-export, transfer or otherwise make available the Software to any
person, or use it in any manner, or be involved in any act, that could result in ESET or its holding companies, its
subsidiaries, and the subsidiaries of any of its holding companies, as well as entities controlled by its holding
companies ("Affiliates") being in violation of, or being subject to, negative consequences under trade control laws
which include:
i. any laws that control, restrict, or impose licensing requirements on export, re-export or transfer of goods,
software, technology, or services, issued or adopted by any government, state or regulatory authority of the
United States of America, Singapore, the United Kingdom, the European Union or any of its Member States, or
any country in which obligations under the Agreement are to be performed, or in which ESET or any of its
Affiliates are incorporated or operate, and
ii. any economic, financial, trade or other, sanction, restriction, embargo, import or export ban, prohibition on
transfer of funds or assets or on performing services, or equivalent measure imposed by any government, state or
regulatory authority of the United States of America, Singapore, the United Kingdom, the European Union or any
of its Member States, or any country in which obligations under the Agreement are to be performed, or in which
ESET or any of its Affiliates are incorporated or operate.
(legal acts referred to in points i, and ii. above together as "Trade Control Laws").
b) ESET shall have the right to suspend its obligations under, or terminate, these Terms with immediate effect in
the event that:
i. ESET determines that, in its reasonable opinion, the User has breached or is likely to breach provision of Article
19 a) of the Agreement; or
ii. the End User and/or the Software become subject to Trade Control Laws and, as a result, ESET determines that,
in its reasonable opinion, the continued performance of its obligations under the Agreement could result in ESET
or its Affiliates being in violation of, or being subject to negative consequences under, Trade Control Laws.
c) Nothing in the Agreement is intended, and nothing should be interpreted or construed, to induce or require
either party to act or refrain from acting (or to agree to act or refrain from acting) in any manner which is
inconsistent with, penalized, or prohibited under any applicable Trade Control Laws.
20. Notices. All notices and return of the Software and Documentation must be delivered to: ESET, spol. s r. o.,
Einsteinova 24, 85101 Bratislava, Slovak Republic.
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21. Applicable law. This Agreement shall be governed by and construed in accordance with the laws of the Slovak
Republic. The End User and the Provider hereby agree that the principles of the conflict of laws and the United
Nations Convention on Contracts for the International Sale of Goods shall not apply. You expressly agree that any
disputes or claims ensuing from this Agreement with respect to the Provider or any disputes or claims relating to
use of the Software shall be settled by Bratislava I District Court and You expressly agree to the said court
exercising jurisdiction.
22. General provisions. Should any of the provisions of this Agreement be invalid or unenforceable, this shall not
affect the validity of the other provisions of the Agreement, which shall remain valid and enforceable under the
conditions stipulated therein. In case of a discrepancy between language versions of this Agreement, the English
version shall prevail. This Agreement may only be modified in written form, signed by an authorized
representative of the Provider, or a person expressly authorized to act in this capacity under the terms of a power
of attorney.
This is the entire Agreement between the Provider and You relating to the Software and it supersedes any prior
representations, discussions, undertakings, communications or advertising relating to the Software.
EULA ID: BUS-ESMC-20-01

Privacy policy
ESET, spol. s r. o., having its registered office at Einsteinova 24, 851 01 Bratislava, Slovak Republic, registered in
the Commercial Register administered by Bratislava I District Court, Section Sro, Entry No 3586/B, Business
Registration Number: 31333532 as a Data Controller ("ESET" or "We") would like to be transparent when it comes
to processing of personal data and privacy of our customers. To achieve this goal, We are publishing this Privacy
Policy with the sole purpose of informing our customer ("End User" or "You") about following topics:
• Processing of Personal Data,
• Data Confidentiality,
• Data Subject's Rights.

Processing of Personal Data
Services provided by ESET implemented in our product are provided under the terms of End User License
Agreement ("EULA"), but some of them might require specific attention. We would like to provide You with more
details on data collection connected with the provision of our services. We render various services described in
the EULA and product documentation such as update/upgrade service, ESET LiveGrid®, protection against misuse
of data, support, etc. To make it all work, We need to collect the following information:
• Management of ESET security products requires and locally stores information such as seat ID and name,
product name, license information, activation and expiration information, hardware and software information
concerning managed computer with ESET security product installed. Logs concerning activities of managed ESET
security products and devices are collected and available in order to facilitate managing and supervising
features and services without automated submission to ESET.
• Information concerning installation process, including platform on which our product is installed and
information about the operations and functionality of our products such as hardware fingerprint, installation
IDs, crash dumps, license IDs, IP address, MAC address, configuration settings of product which may also
include managed devices.
• Licensing information such as license ID and personal data such as name, surname, address, email address is
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required for billing purposes, license genuineness verification and provision of our services.
• Contact information and data contained in your support requests may be required for service of support.
Based on the channel You choose to contact us, We may collect your email address, phone number, license
information, product details and description of your support case. You may be asked to provide us with other
information to facilitate service of support such as generated log files.
• Data concerning usage of our service are completely anonymous by the end of session. No personally
identifiable information is stored after the session ends.

Data Confidentiality
ESET is a company operating worldwide via affiliated entities or partners as part of our distribution, service and
support network. Information processed by ESET may be transferred to and from affiliated entities or partners for
performance of the EULA such as provision of services or support or billing. Based on your location and service
You choose to use, We might be required to transfer your data to a country with absence of adequacy decision by
the European Commission. Even in this case, every transfer of information is subject to regulation of data
protection legislation and takes place only if required. Standard Contractual Clauses, Binding Corporate Rules or
another appropriate safeguard must be established without any exception.
We are doing our best to prevent data from being stored longer than necessary while providing services under
the EULA. Our retention period might be longer than the validity of your license just to give You time for easy and
comfortable renewal. Minimized and pseudonymized statistics and other data from ESET LiveGrid® may be
further processed for statistical purposes.
ESET implements appropriate technical and organizational measures to ensure a level of security which is
appropriate to potential risks. We are doing our best to ensure the ongoing confidentiality, integrity, availability
and resilience of processing systems and Services. However, in case of data breach resulting in a risk to your rights
and freedoms, We are ready to notify supervisory authority as well as data subjects. As a data subject, You have a
right to lodge a complaint with a supervisory authority.

Data Subject’s Rights
ESET is subject to regulation of Slovak laws and We are bound by data protection legislation as part of European
Union. Subject to conditions laid down by applicable data protection laws, You are entitled to following rights as a
data subject:
• right to request access to your personal data from ESET,
• right to rectification of your personal data if inaccurate (You also have the right to have the incomplete
personal data completed),
• right to request erasure of your personal data,
• right to request restriction of processing your personal data,
• right to object to processing,
• right to lodge a complaint as well as,
• right to data portability.
If You would like to exercise your right as a data subject or You have a question or concern, send us a message at:
ESET, spol. s r.o.
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Data Protection Officer
Einsteinova 24
85101 Bratislava
Slovak Republic
dpo@eset.sk
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